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© 2004 National Instruments Corporation. All rights reserved.

Conventions

This help file uses the following conventions:

< >
Angle brackets that contain numbers separated by an ellipsis represent a range
of values associated with a bit or signal name—for example, dBIO<3..0>.

[ ] Square brackets enclose optional items—for example, [response].

»

The » symbol leads you through nested menu items and dialog box options to a
final action. The sequence File»Page Setup»Options directs you to pull down
the File menu, select the Page Setup item, and select Options from the last
dialog box.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to avoid
injury, data loss, or a system crash.

bold
Bold text denotes items that you must select or click on in the software, such as
menu items and dialog box options. Bold text also denotes parameter names,
emphasis, or an introduction to a key concept.

dark red Text in this color denotes a caution.

green
Underlined text in this color denotes a link to a help topic, help file, or Web
address.

italic
Italic text denotes variables or cross references. This font also denotes text that
is a placeholder for a word or value that you must supply.

monospace

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples. This
font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames and extensions, and code excerpts.

monospace italic
Italic text in this font denotes text that is a placeholder for a word or value that
you must supply.
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Key Terms

You may find the following definitions helpful as you use this document:

AWG

Arbitrary Waveform Generator −− refers to the NI 5421 arbitrary waveform generator hardware module.

Average Power

The NI−RFSG software allows you to specify the power level of the RF output signal. NI−RFSG
interprets this power level to mean average power level.

The average power level of a signal can be measured at least two ways:

Using a power meter, or1. 
Performing a power in band measurement across the entire signal bandwidth on a spectrum
analyzer.

2. 

The following graphs depict the average power of two signals created by a NI 5670 with an NI−RFSG
power level setting of −20 dBm:

Narrowband Signal: Average Power −20 dBm
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QAM Wideband Signal: Average Power −20 dBm

Specify the average power using the niRFSG Configure RF VI or the niRFSG_Configure RF function.

Baseband

Refers to the range in the frequency spectrum occupied by the unmodulated information signal. Both the
information signal and the complex I−Q signal are referred to as baseband signals.

IF

Intermediate Frequency −− refers to the signal passed from the NI 5421 AWG module front panel CH 0
SMA connector to the NI 5610 upconverter module front panel INPUT SMA connector. This signal is
upconverted to the requested RF output signal.

Module

Refers to one of the hardware components of the NI 5670: the NI 5421 arbitrary waveform generator or
the NI 5610 wideband RF upconverter.

PLL

Phase−Locked Loop −− refers to an electronic circuit that controls an oscillator so that the circuit
maintains a constant phase angle relative to a reference signal. The main function of a PLL is to adjust the
frequency of the onboard oscillator so that it matches that of an externally provided reference clock.

RF

Radio Frequency −− refers to the signal output from the RF OUTPUT connector on the NI 5610
upconverter module front panel.
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Upconverter

A device that frequency−translates IF signals to center around a specified RF frequency −− refers to an NI
5610 2−slot RF upconverter hardware module.

Software Fundamentals

NI−RFSG Instrument Driver

The NI−RFSG instrument driver software controls all NI 5670 configuration and operation using
LabVIEW VIs or LabWindows/CVI functions. The modules are associated in MAX, allowing the
NI−RFSG instrument driver to transparently operate the NI 5610 upconverter module and the NI 5421
AWG module as a single instrument (the NI 5670).

The NI−RFSG driver configures and operates the NI 5670 hardware, performs waveform programming
and generation, and is capable of basic IQ modulation tasks. Add−on software available from NI, such as
the Modulation Toolkit (optional) and the Spectral Measurements Toolkit (included), extends the
capability of the NI 5670 to include additional frequency−domain and modulation−domain tasks.

This section provides reference information regarding the NI−RFSG programming flow, state model,
when to call NI−RFSG VIs/functions, information on installed examples, and basic NI−RFSG application
building.

Refer to the NI−RFSG LabVIEW reference or the LabWindows/CVI reference sections for more
information about using specific LabVIEW VIs, CVI functions, and properties.

The Spectral Measurements Toolkit

The Spectral Measurements Toolkit (SMT) contains functions for generating and analyzing analog
modulated signals. Supported modulation formats include Amplitude Modulation (AM), Frequency
Modulation (FM), and Phase Modulation (PM). SMT functions also perform frequency domain analysis
tasks such as the zoom FFT and spectrum averaging, and measurements such as power in band and
adjacent channel power.

Refer to the Spectral Measurements Toolkit Online Help, available at Start»Programs»National
Instruments»Spectral Measurements, for detailed information on using the SMT.

NI−RFSG Instrument Driver Programming Flow

NI−RFSG VIs are located on the LabVIEW functions palette at Instrument I/O»Instrument
Drivers»NI−RFSG. The top−level NI−RFSG functions palette is shown in the figure below:
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NI−RFSG LabVIEW Palette. Core VIs are Highlighted

Every application using NI−RFSG must call the five VIs highlighted on the palette image above. These
VIs are arranged from left to right in the order they must be called:

1. niRFSG Initialize — Opens a session to the NI−RFSG device and initializes both the AWG and
the upconverter hardware.

2. niRFSG Configure RF — Configures the frequency and power level of the RF output signal.

3. niRFSG Initiate — Initiates signal generation.

4. niRFSG Check Generation Status — Monitors signal generation status and checks for any errors
which may occur during signal generation.

4. niRFSG Configure Output Enabled — Disables signal output at the NI 5610 upconverter module
front panel RF OUT connector.

5. niRFSG Close — Closes the NI−RFSG session, and deallocates memory resources used by
NI−RFSG. You must call this VI once for every session opened with niRFSG Initialize.

NI 5670 Programming State Model

The NI−RFSG programming model has three main states: Configuration (Idle), Committed, and
Generation (Running). The programming state model below depicts the programming state model for the
NI−RFSG hardware and software.
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NI−RFSG Programming State Model

Configuration—

You can program all session properties in the Configuration state. However, when in the
Configuration state, the properties have not yet been applied to the hardware module.
Therefore the module configuration may not match the session property values. The
NI−RFSG device does not generate a signal in the Configuration state.

Committed—

Calling niRFSG Commit from the Configuration state performs the following actions:

Verifies all property settings• 
Validates the specified configuration• 
Writes all settings to the hardware modules• 
Writes the waveform to the AWG module onboard memory• 
Transitions to the Committed state• 

If any properties are changed while in the Committed state, the session implicitly
transitions back to the Configuration state and the hardware configuration reflects the
previously committed properties.

Generation—

In the Generation state, session properties always reflect the current state of the module,
and the module is either waiting on a trigger or generating a signal.

Note  NI−RFSG cannot set any attributes or write data during the Generation
State.

Note  niRFSG Close may be called from any state. Calling Close stops signal
generation.
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When to Use a VI

VI Name
Call During

Configuration State?

Call During
Committed/Generation

State?

Check Generation Status No Yes

Clear All Arb Waveforms Yes No

Configure IQ Enabled Yes No

niRFSG Configure Output Enabled Yes Yes

Configure PXI Chassis Clk 10 Yes No

Configure Reference Clock Yes No

Configure RF Yes No

Configure Trigger Yes No

Error Message Yes No

Query Arb Waveform Capabilities Yes No

Reset Yes No

Reset Device Yes Yes

Revision Query Yes No

Self Cal Yes No

Self Test Yes No

Send Software Edge Trigger No Yes

Wait Until Settled No Yes

Write Arb Waveform Yes No

Installed Examples

NI−RFSG includes several example applications for both LabVIEW and LabWindows/CVI. These
examples are intended to serve as interactive tools, programming models, and as building blocks in your
own applications.

With LabVIEW running, select Help»Find Examples to launch the LabVIEW Example Finder. The
Example Finder offers two ways to access all installed LabVIEW example VIs and their descriptions:

Click the Browse tab to locate an NI−RFSG example by task at Hardware Input and
Output»Modular Instruments»NI−RFSG or by directory structure at instr\niRFSG

• 

Click the Search tab to search all installed LabVIEW examples by keyword. Enter the keyword
FM, for instance, to locate an example demonstrating FM signal generation using the NI 5670

• 
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and the NI Modulation Toolkit (if installed).

LabVIEW and LabWindows/CVI users can also access all installed NI−RFSG examples at
Start»Programs»National Instruments»NI−RFSG»Examples. View LabVIEW examples by navigating
to the <LabVIEW home>examples\instr\niRFSG folder. View examples for CVI by navigating to the
<Program Files>\IVI\Drivers\niRFSG\Examples directory.

Examples are also available online at ni.com/examples that demonstrate integrating the NI 5670 RF
Vector Signal Generator hardware and software with the NI 5660 RF Signal Analyzer and NI toolkit
software including the Modulation Toolkit. Refer to the NI Developer Zone on the Web at
ni.com/examples for these examples and more information.

Building a Basic NI−RFSG Application

Use the following procedure to begin using NI−RFSG to generate a signal:

Select Start»Programs»National Instruments»LabVIEW 7»LabVIEW to launch LabVIEW. The
LabVIEW dialog appears.

1. 

Click New, choose Blank VI, and click OK to create a blank VI.2. 
Display the block diagram by clicking it or selecting Window»Show Block Diagram.3. 
Navigate to the NI−RFSG VIs on the Functions»Instrument I/O»Instrument
Drivers»NI−RFSG palette. With LabVIEW running, click here to find the NI−RFSG LabVIEW
palette.

4. 

Create the block diagram shown in Figure 1 by placing the five core VIs on the block diagram in
the order they appear in the top row of the NI−RFSG functions palette.

5. 

Figure 1: Basic NI−RFSG Block Diagram

Hover the cursor over the resource name terminal on the niRFSG Initialize VI and right−click.
Select Create»Control to create a front panel field where you specify the NI 5670 device name.
The resource name terminal is highlighted in Figure 2 below.

6. 

Figure 2: Resource Name Terminal on niRFSG Initialize VI

Hover the mouse tool over the frequency and power level terminals of the niRFSG Configure RF
VI. The terminals are highlighted in Figure 3:

7. 
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Figure 3. Frequency and Power Level Terminals on the niRFSG Configure RF VI

Right−click each terminal and select Create»Control from the shortcut menu to create frequency
and power controls as shown in Figure 4.

8. 

Figure 4. Frequency and Power Level Controls on the Block Diagram

Display the front panel by clicking it or selecting Window»Show Front Panel. Fields are
displayed in which you can specify a frequency and power level.

9. 

In the VI front panel power level (dBm) field, type 0. In the frequency (Hz) field, type 100M
(100 MHz).

10. 

In the VI front panel resource name field, type the NI 5610 upconverter module name that you
specified in MAX. The NI 5610 upconverter module must be associated with a NI 5421 AWG
module. Refer to the NI 5670 Getting Started Guide, installed at Start»Programs»National
Instruments»NI−RFSG»Documentation, for more information.

11. 

Continous waveform generation is controlled by means of a STOP button. A STOP button is typically
used within a While Loop. This example places a While Loop around the Check Generation Status VI so
that signal generation continues and waveform status is continuously checked until you click STOP.

Build a While Loop and STOP button by completing the following steps.

Display the block diagram by clicking it or selecting Window»Show Block Diagram.1. 
Select the While Loop on the All Functions»Structures palette. With LabVIEW running, click
here to find the While Loop on the Structures palette.

2. 

Enclose the niRFSG Check Generation Status VI in the While Loop, as shown in Figure 5 below.3. 
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Figure 5. Enclose niRFSG Check Generation Status VI in the While Loop

Hover the mouse tool over the Loop Condition terminal of the While Loop. The terminal is
highlighted in Figure 6 below.

4. 

Figure 6. Loop Condition Terminal on While Loop

Right−click the Loop Condition terminal and select Create Control from the shortcut menu to
create a STOP button on the VI front panel. The resulting portion of the block diagram is shown
in Figure 7.

5. 

Figure 7. While Loop with Stop Button

10



Create an error indicator by right−clicking on the error out terminal of the niRFSG Close VI and
selecting Create»Indicator. The error out terminal is highlighted in Figure 8 below:

6. 

Figure 8. Error Out Terminal on niRFSG Close VI

Verify that your VI block diagram now looks like the example in Figure 9 below.7. 

Figure 9. Basic Sine Wave Generation VI Block Diagram

Display the VI front panel by clicking it or by selecting Window»Show Front Panel. Verify that
your VI front panel looks like the example in Figure 10 below.

8. 
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Figure 10. Basic Sine Wave Generation VI Front Panel

Note  The resource name control is populated with the NI 5610 upconverter module name
specified in MAX; refer to the NI 5670 Getting Started Guide, installed at
Start»Programs»National Instruments»NI−RFSG»Documentation, for more information.

Click the Run icon on the VI taskbar  to initiate sine wave generation.9. 
Click the front panel Stop button  to stop sine wave generation.10. 

Note  Always stop VI operation using the front panel STOP button you created. Never stop a VI
with the ABORT button on the taskbar. The ABORT button does not free memory resources and
leaves hardware and software in an unknown state.

You have successfully generated a continuous sine wave signal using the NI−RFSG driver software and
the NI 5670 hardware.

NI 5670 RF Vector Signal Generator

Hardware Reference
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This section includes information relevant to the use the NI 5670 hardware modules. NI−RFSG hardware
specifications are available at Start»Programs»National
Instruments»NI−RFSG»Documentation»Specifications.

NI 5670 Overview

The NI 5670 is a modular RF signal source consisting of two PXI hardware modules:

NI 5421 −− 16 bit, 100 megasample−per−second (MS/s) arbitrary waveform generator (AWG)
module (400 MS/s interpolated).

• 

NI 5610 −− 2.7 GHz RF superheterodyne upconverter module.• 

Note  There is no physical device labeled the "NI 5670." The NI 5670 is the instrument comprised of
the two hardware modules (NI 5610 and NI 5421) operated by the NI−RFSG instrument driver.

The hardware modules interconnect using the included SMA−SMB coaxial cables as illustrated below.

Interconnected NI 5670 Front Panels
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The NI 5670 has the following characteristics and features:

250 kHz to 2.7 GHz frequency range• 
+13 dBm to −145 dBm amplitude range• 
22 MHz real−time bandwidth• 
10 MHz oven−controlled crystal oscillator (OCXO) timebase• 

±20 ppb frequency stability♦ 
±50 ppb frequency accuracy♦ 

132 dB compression−to−noise dynamic range• 
<−119 dBc/Hz typical noise density• 
Up to 256 MB of AWG module onboard waveform memory (see Memory Options for details)• 
NI−RFSG instrument driver software transparently operates both modules as a single unit.• 
Three slots wide PXI/3U Compact PCI form factor• 

The NI 5670 follows industry−standard Plug and Play specifications for the PXI bus, and can be
seamlessly integrated with compliant systems.

NI 5670 Theory of Operation

The NI 5670 RF Vector Signal Generator hardware consists of two parts: the NI 5421 arbitrary waveform
generator (AWG) module and the NI 5610 RF upconverter module. The NI 5421 generates a signal
centering at an intermediate frequency (IF) between 15 and 35 MHz. The IF signal is fed into the
NI 5610, which frequency−translates its center frequency to anywhere up to 2.7 GHz.

The NI−RFSG driver software operates both hardware modules as a single instrument by handling all
module programming and interaction. When the user specifies a carrier frequency and power for the RF
output signal, NI RFSG selects the appropriate IF frequency and power level settings for the NI 5421
AWG module, and the frequency shift and gain or attenuation settings for the NI 5610 upconverter
module.

The power and carrier frequency of the IF signal generated by the NI 5421 are determined by the
NI−RFSG software. To optimize dynamic range, NI−RFSG attempts to use the full scale of the NI 5421
digital−to−analog converter (DAC), and adjust output signal power by means of the NI 5610 attenuators.

The NI 5610 contains a stable and accurate 10 MHz frequency reference. A coaxial cable feeds the
reference out of the front panel of the NI 5610 and into the NI 5421. The NI 5421 locks its internal
reference clock to this reference.

Note  NI 5670 operation requires that the NI 5610 module front panel conector labeled
10 MHz OUT (TO AWG CLK IN) be connected to the NI 5421 module front panel connector
labeled CLK IN. Most timing configurations generate an error if this interconnection is not in place.

The NI 5610 reference can also be locked to an external 10 MHz frequency reference. The source of this
external reference can be either the REF IN connector on the NI 5610 module front panel or the PXI
CLK 10 backplane signal.
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The NI 5610 accomplishes its frequency shifting by mixing the IF signal with local oscillators in the
NI 5610 signal chain circuit. One of these local oscillator (LO) signals can be tuned from 3.2 GHz to 5.9
GHz. There is a separate output on the NI 5610 module front panel (LOCAL OSC OUT 0) from which
you may export this LO signal if it has been enabled using the Local Oscillator Out 0 Enabled property.

NI−RFSG software automatically compensates for temperature−induced changes in the output power
levels of the NI 5670 modules. Power variation versus temperature is calibrated during factory calibration
and stored in nonvolatile memory on each module. NI−RFSG reads this information from both modules.
It also reads the temperature of each module from onboard temperature sensors, and uses this information
to adjust the final power level accordingly.

NI 5670 Flow Diagram

Power Up and Reset Conditions

The NI 5670 hardware is in the following state after powering on or restarting the system and allowing
the PC operating system and the NI−RFSG driver to fully load. These conditions are also true after a
device reset (performed directly from MAX or by calling the niRFSG Reset Device VI or function).

Thermal shutdown monitoring is activated.• 
NI 5610 RF enclosure is powered on• 
Both module front panel ACCESS LEDs are green.• 
The LOCAL OSC OUT 0 module front panel output connector is disabled.• 
Reverse power protection relay is open.• 
All attenuators are asserted• 
Both module front panel ACTIVE LEDs are OFF.• 
RF output power is set to < −140 dBm.• 
Realtime bandwidth is set to 100 Hz.• 
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NI 5610 onboard 10 MHz reference clock is set as the NI 5670 reference clock.• 
Warmup begins (if applicable)• 

Hardware Front Panel Connectors and Indicators

These sections describe the connectors and LED indicators on the front panels of both NI 5670 hardware
modules. All inputs and outputs are AC−coupled.

NI 5610 Upconverter Module

The following figure shows the NI 5610 RF upconverter front panel, which contains six connectors and
two multicolor LEDs:

The following table provides connector and use information for the NI 5610 RF upconverter module front
panel connectors:

   NI 5610 Front Panel

Connector Use

10 MHz OUT
(TO AWG CLK IN)

Connect the upper of these
two connectors to the CLK IN
connector on the NI 5421
front panel.

Both connectors output
replications of the upconverter
10 MHz frequency reference
signal, useful for driving other
devices. Each replication is
180° out−of−phase with the
other. Output at these
connectors is always on.

10 MHz OUT

REF IN

Inputs an external frequency
reference signal which can be
propagated to the PXI
backplane. The NI 5610 can
lock to this signal.

IF INPUT

Inputs the IF signal from the
NI 5421 AWG module for
frequency translation.

Connect to the CH 0 output on
the NI 5421 front panel.

LOCAL OSC OUT 0 Outputs the local oscillator
signal. Output at this
connector is enabled using the
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Local Oscillator Out 0
Enabled property. The
frequency of this LO signal is
always about 3.2 GHz greater
than the output signal.

RF OUTPUT
Outputs the upconverted
signal at the requested RF
frequency.

The following table provides LED and indications
information for the NI 5610 RF upconverter module front
panel LEDs:

LED Indications

ACCESS

Indicates the basic hardware status of the NI 5610
module. This LED functions identically to the
ACCESS LED on the AWG module front panel:

OFF—The module is not yet functional.

AMBER—The module is being accessed by the
PXI bus.

GREEN—The module is ready to be programmed
by a driver.

ACTIVE

Indicates the state of the NI 5610 hardware:

OFF—The module is in an uninitialized state;
there is no error.

AMBER—The module PLLs are attempting to
lock.

GREEN—The module is in a ready state;
applicable PLLs are locked and the reverse power
protection circuit is closed.

RED—The module has detected an error state;
this may indicate an overload (reverse power
protection circuit is open), lock failure in an
applicable PLL, a self−test or calibration failure,
or a thermal shutdown condition.
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NI 5421 AWG Module

The following figure shows the NI 5421 AWG module front panel, which contains five connectors and
two multicolor LEDs:

The following table provides connector and use information for the NI 5421 AWG module front panel
connectors:

  NI 5421
Front Panel

Connector Use

CH0

Outputs an IF waveform for upconversion to the desired RF
frequency.

Connect to the IF INPUT connector on the NI 5610 front panel.

CLK IN
Inputs the NI 5421 internal clock reference signal.

Connect to the REF OUT connector on the NI 5610 front panel.

PFI 0 Bidirectional SMB connectors. As an input, the PFI terminals can
accept a trigger from an external source to start or step through signal
generation.PFI 1

The following table provides LED and indications information for the NI 5421 AWG
module front panel LEDs:

LED Indications

ACCESS

Indicates the basic hardware status of the NI 5421 module. This LED functions
identically to the ACCESS LED on the upconverter module front panel:

OFF—The module is not yet functional, or has detected a problem with a
power rail.

AMBER—The module is being accessed by the PXI bus.

GREEN——The module is ready to be programmed by a driver.

ACTIVE Indicates the state of the NI 5421 hardware module:

OFF—The module is not armed or triggered.

AMBER—The module is armed and waiting for a start trigger.

GREEN—The module has received a start trigger and is generating a
waveform.
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RED—The module has detected an error state; this may indicate PLL
unlocking, self−test failure or calibration failure.

NI 5421 AWG Module

The NI 5421, shown below, is a single−channel 16−bit 100 MS/s arbitrary waveform generator module.

NI 5421 AWG Module

For complete, in−depth information specific to the NI 5421 AWG module and its use as a standalone
device, refer to the NI Signal Sources Help, located at Start»Programs»National
Instruments»NI−FGEN»Documentation.

Memory Options

The NI 5421 can be purchased with three onboard waveform memory size options: 8 MB, 32 MB, and
256 MB. The memory size chosen affects both NI 5670 playback time and tuning resolution for repetitive
waveforms.

Onboard waveform memory size dictates playback time, or the maximum time duration for which
arbitrary waveforms can be generated without repeating the same waveform data. If your application
requires complex IQ waveform playback for long time durations without looping, choose a larger
NI 5421 onboard waveform memory option. For example, 256 MB of onboard memory can store
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approximately 1.28 seconds of waveform data at the default sample clock rate of 100 MS/s. 32 MB of
onboard memory can store about 0.16 seconds of 100 MS/s waveform data, and 8 MB can store
approximately 0.04 seconds.

Another benefit of large AWG onboard memory sizes, however, is finer frequency resolution in repetitive
playback of the generated waveform. As discussed in the Phase Continuity section, frequency resolution
for arbitrary waveforms is limited by available memory size when phase continuity is enabled. When the
Phase Continuity Enabled property is set to FALSE, this limitation on frequency resolution does not
apply.

The table below lists the playback time and the maximum frequency resolution that can be obtained for
each memory option using the default sample clock rate of 100 MS/s and phase continuity enabled.

Memory Size (MB) Playback Time Without Looping (msec)

8 40

32 160

256 1280

Memory Sizes versus Playback Time and Frequency Resolution

Note  Not all onboard memory can be used for waveform storage. The onboard memory is shared
between waveforms and instructions that indicate how the waveform is to be generated.

NI 5610 Upconverter Module

The NI 5610, shown below, is a 250 kHz to 2.7 GHz superheterodyne upconverter hardware module that
frequency−translates IF input signals between 15 MHz and 35 MHz to a desired RF frequency between
250 kHz and 2.7 GHz.
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The NI 5610 Upconverter Module

Note  The NI 5610 upconverter module (two slots wide) is connected to the PXI backplane through
the leftmost of its two occupied PXI slots. Thus installing the NI 5610 module in PXI Slot 2, for
instance, occupies PXI Slots 2 and 3. Slot numbers are printed on the PXI chassis.

The NI 5610 offers 22 MHz real−time bandwidth and an on−board 10 MHz highly stable, low phase
noise ovenized crystal oscillator (OCXO) reference clock that can be software−configured to drive the
PXI 10 MHz backplane clock only when the NI 5610 is installed in PXI Slot 2.
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The NI 5610 can Drive the PXI backplane Clock from PXI Slot 2

Two replications of the NI 5610 onboard 10 MHz reference clock signal are output from the NI 5610
module front panel connectors labeled REF 1 and REF 2. Each replication is 180° out−of−phase from the
other. Output at these connectors is always on. Refer to Timing Configurations for more information.
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NI 5610 High−Level Block Diagram

Frequency Translation

The NI 5610 frequency translation process occurs through several different conversion stages. Each stage
consists of amplifiers, filters, attenuators, and mixers.

23



The NI 5610 has 121 dB of available attenuation range, adjustable in steps of 1 dB (nominal). The
attenuators are dispersed throughout the NI 5610 signal chain circuit to optimize the system performance.
The NI 5610 is designed to be used with the NI 5421 AWG module, which provides the fine power
control adjustment of the NI 5670 Vector Signal Generator. Refer to Power Level Adjustment for more
information.

If the output frequency is varied while keeping output power levels constant, the attenuator settings and
the IF power may vary automatically to maintain constant output power.

Local Oscillators

The local oscillators (LO) provide the signals required for mixing in the upconversion process. The local
oscillators are phase−locked to the onboard reference OCXO at all times. They cannot lock to external
reference directly; only the OCXO can lock directly to external references. The user can access the final
LO signal via the front panel SMA connector labeled LOCAL OSC OUT 0 by setting the
NIRFSG_ATTR_LOCAL_OSCILLATOR_OUT_0_ENABLED property to ENABLE. The frequency of
this LO varies between 3.2 GHz and 5.9 GHz, depending upon the specified output frequency and
intermediate frequencies automatically chosen by NI−RFSG.

NI 5610 Onboard Reference Clock

The NI 5610 onboard 10 MHz OCXO reference clock offers superior accuracy and phase noise
specifications to the 10 MHz reference built into most PXI chassis. When the NI 5610 is installed in
PXI Slot 2, this reference can be used to drive the 10 MHz PXI backplane clock and serve as the master
reference for the PXI system. See Timing Configurations for information on how to configure this option.
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timing circuit block diagram

The figure above shows the routing of the 10 MHz frequency references. Notice that when the NI 5610 is
programmed to lock to an external reference, the local oscillators (LOs) still lock to the onboard OCXO,
which is locked to the external reference.

Refer to the NI 5670 Specifications document, located at Start»Programs»National
Instruments»NI−RFSG»Documentation, for NI 5610 onboard OCXO frequency reference
specifications.

Timing Configurations

The timebases of both NI 5670 hardware modules (NI 5421 AWG module and the NI 5610 upconverter
module) must be frequency−locked to a common 10 MHz reference clock. The following clock sources
are available:

10 MHz NI 5610 Onboard Reference Clock• 
10 MHz External Reference Clock (connected to NI 5610 Front Panel REF IN Connector)• 
PXI 10 MHz Backplane Clock• 

The NI 5610 onboard frequency reference (a very accurate and stable OCXO) can drive the 10 MHz PXI
backplane clock only if the upconverter module is installed in PXI Slot 2. When the NI 5610 is installed
in PXI Slot 2, you can configure it to drive the 10 MHz PXI backplane clock with the NI 5610 onboard
frequency reference or with an external frequency source connected to the REF IN connector on the
NI 5610 module front panel.
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Available timing configurations are shown in the table below.

Timing Configuration
NI 5610
PXI Slot
Location

Module Front Panel Connections
How to

Configure

NI 5421 locked to NI 5610
onboard OCXO, 10 MHz
PXI backplane clock
independent

Any PXI slot

Connect the TO AWG CLK IN
connector on the NI 5610 module front
panel to the CLK IN connector on the
NI 5421 front panel

Set the Ref Clock
Source property to
OnBoardClock;
Set the PXI
Chassis Clk 10
Source property to
None.

This is the default
configuration in
the NI−RFSG
driver software

NI 5421 locked to NI 5610
onboard OCXO, 10 MHz
PXI backplane clock
locked to NI 5610 onboard
OCXO

PXI Slot 2
only

Connect the TO AWG CLK IN
connector on the NI 5610 module front
panel to the CLK IN connector on the
NI 5421 front panel

Set the Ref Clock
Source property to
OnBoardClock;
Set the PXI
Chassis Clk 10
Source property to
OnBoardClock.

NI 5610 and NI 5421
locked to external
reference, 10 MHz PXI
backplane clock
independent

Any PXI slot

Connect the TO AWG CLK IN
connector on the NI 5610 module front
panel to the CLK IN connector on the
NI 5421 front panel; external reference
signal attached to the NI 5610 REF IN
connector

Set the Ref Clock
Source property to
RefIn; Set the PXI
Chassis Clk 10
Source property to
None.

NI 5610 and NI 5421
locked to external
reference, 10 MHz PXI
backplane clock locked to
external reference

PXI Slot 2
only

Connect the TO AWG CLK IN
connector on the NI 5610 module front
panel to the CLK IN connector on the
NI 5421 front panel; external reference
signal attached to the NI 5610 REF IN
connector

Ref Clock Source
property to RefIn;
Set the PXI
Chassis Clk 10
Source property to
RefIn.

NI 5670 locked to 10 MHz
PXI backplane clock*

Any PXI slot
No front panel connections are
required

Set the Ref Clock
Source property to
PXI_CLK_10; Set
the PXI Chassis
Clk 10 Source
property to None.

*The onboard reference of the NI 5610 offers far superior frequency stability and phase noise than the

26



frequency reference built into most PXI chassis. Do not lock to the 10 MHz PXI backplane clock unless
it is driven by a high−accuracy reference (built−in or installed in PXI Slot 2).

Using an External Reference Clock Via the Front Panel

The NI 5670 can be programmed to phase lock to a 10 MHz external reference clock signal connected to
the NI 5610 module front panel SMA connector labeled REF IN.

The pulling range of the NI 5610 onboard OCXO is specified at +/− 10 Hz, but may be as large as
+/− 15 Hz. Pulling range is the amount of frequency variation tolerable in an external reference clock
signal to which the NI 5610 onboard OCXO can be electronically locked. This implies that the external
reference signal must be accurate to within +/− 10 Hz in order for the NI 5610 onboard OCXO to phase
lock to it. Reference signal accuracy is the frequency offset observed from a rubidium source at 25 °C
room temperature. Most references available on the market do not meet the NI 5610 pulling range
requirement due to variability with temperature.

The phase noise of the system is also affected by external phase locking. Although the NI 5670 tries to
minimize the effect of noisy references by using a very small phase−locked loop bandwidth, a
considerable remnant may exist if the reference phase noise is 20 dB to 30 dB poorer than the NI 5610
onboard OCXO. Some rubidium sources on the market have more phase noise than the NI 5610 onboard
reference, but exhibit very high long−term stability.

The external reference signal power level must be > −10 dBm or 0.2 Vp−p into 50 Ohm.

Exporting a Frequency Reference

The onboard reference of the NI 5610 may be exported to other benchtop instruments or PXI modules.

The 10 MHz reference signal from the NI 5610 onboard OCXO is always available on the module front
panel connectors labeled 10 MHz OUT. Both connectors output replications of the upconverter 10 MHz
frequency reference signal, 180° out−of−phase with each other. If the NI 5610 has been configured to
lock to an external reference signal, then the signal output from the 10 MHz OUT NI 5610 module front
panel connector is also locked to the specified reference.

The NI 5610 can also be configured to drive the 10 MHz PXI backplane clock with its highly accurate
onboard reference clock. To do this, the NI 5670 must be installed in PXI Slot 2. The NI 5610 can also be
configured to lock to an external reference clock signal attached the REF IN connector on the module
front panel.

Note  The onboard reference of the NI 5610 offers far superior frequency stability and phase
noise than the frequency reference built into most PXI chassis. Do not lock to the 10 MHz
PXI backplane clock unless it is driven by a high−accuracy reference (built−in or installed in
PXI Slot 2).
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Sine Waveform Mode versus Arbitrary Waveform Mode

In sine waveform generation mode, NI−RFSG software internally calculates a phase−continuous sine
wave signal at commit time. Very narrow output signal bandwidth settings and a sample clock rate of
100 MS/s are always used for sine signal generation. Frequency and power settings relate to the frequency
and power of the sine tone.

In arbitrary waveform generation mode, a user−provided complex IQ baseband signal is upconverted to
IF at commit time. Phase continuity, signal bandwidth and sample clock rate settings are configurable.
Output frequency and power settings relate to the center frequency and average power of the specified
arbitrary waveform.

Note  The maximum allowed peak envelope power (PEP), also called maximum
instantaneous power, is 17 dBm. In sine waveform mode, all envelope power is contained in
the single tone, so tone power levels of up to 17 dBm can be achieved, depending on the
frequency. However, in arbitrary waveform mode the envelope power depends on the
arbitary waveform, and may exceed allowable PEP without peaks at similar power levels.

The following table details the differences between sine and arbitrary waveform generation modes:

Sine Waveform Generation
Mode

Arbitrary Waveform Generation Mode

Output Waveform
Type

sine wave arbitrary waveform

Phase−Continuous always optional, depending on input waveform

Waveform Source driver software−generated user−specified complex baseband IQ data

Sample Clock Rate always 100 MS/s 100 or 50 MS/s

Bandwidth always narrow
specified in the Signal Bandwidth
property

Frequency
specifies the frequency of the
output sine tone

specifies the center frequency of the
output arbitrary waveform

Power Level specifies the sine tone power level
specifies the average power level of the
arbitrary waveform

Digital IF
Equalization

disabled optional

Sample Clock Rate

NI−RFSG provides for two sample clock rates in arbitrary waveform generation mode:

100 megasamples per second (MS/s) −− default• 
50 MS/s• 
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Sine generation mode always uses a sample clock rate of 100 MS/s.

The default sample clock rate for arbitrary waveform generation is 100 MS/s. This setting provides the
best possible anti−aliasing performance, up to 20 MHz of real−time bandwidth, and the best time−domain
resolution of the signal. It is therefore the recommended setting for most applications.

When to Use a 50 MS/s Rate

Two main cases exist in which a sample rate setting of 50 MS/s may be useful:

Very large waveforms − setting the sample clock rate to 50 MS/s halves the memory required to
store the same time duration of a given waveform. For example, if the NI 5421 AWG module is
equipped with the 256 MB memory option, 1.28 seconds of data sampled at 100MS/s (equivalent
to 227 samples) can be stored in the NI 5421 onboard memory. By contrast, approximately 2.56
seconds of data sampled at 50 MS/s (equivalent to 228 samples) can be stored in the same amount
of memory.

1. 

Note  Not all available onboard memory can be used for waveform storage. The onboard
memory is shared between waveforms and instructions that indicate how the waveform is to
be generated.

Speed optimization − setting the sample clock to 50 MS/s can improve speed performance if
resampling of the signal is required. The resampling process can consume significant CPU time,
and the larger the resampling ratio (final sample rate / initial sample rate) the more time
resampling takes. Therefore, resampling to 50 MS/s will be less time−consuming than resampling
to 100 MS/s.

2. 

Implications of Using a 50 MS/s Rate

Setting the sample clock rate to 50 MS/s has the following implications:

The NI−RFSG driver will place the IF carrier frequency at 20MHz +− 2.5MHz to avoid aliasing.
However, forcing the IF carrier frequency at that point implies that the NI−RFSG driver will not have
the freedom to pick an IF carrier frequency that could optimize the waveform size if phase continuity is
enabled.

• 

Output signal bandwidth must be less than 5 MHz. This constraint is due to the Nyquist frequency
(25 MHz) and to the upconverter input IF range (15 MHz to 35 MHz).

• 

Phase Continuity

An array containing a sine wave is phase−continuous if the phase of its last point is equal to the phase of
its first point minus the phase difference between any two adjacent samples (modulo 2). In other words,
a sinusoidal waveform array is phase−continuous if it contains an integer number of cycles of the
sinusoid.

An arbitrary array is phase−continuous if the phase of its last point is equal to the phase of its first point
minus the phase difference between any two adjacent samples (modulo 2) for every frequency
component of the array.
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The user−specified baseband IQ waveform downloaded input to the NI 5421 is upconverted to an IF
waveform which is input to the NI 5610 upconverter module. The IF waveform must be
phase−continuous or a phase glitch appears in the RF output signal when the waveform loops back to the
beginning of the array. The IF waveform array will only be phase−continuous if the array contains an
integer number of cycles of the IF frequency.

Figure 1. A sine wave sampled at two different sample rates.
Circles represent phase−continuous sampling of the sine wave. Squares represent non−continuous

sampling of the sine wave.

Phase glitches in the RF output signal that are due to a non−integer number of samples in the IF
waveform can be addressed by repeating the original IF waveform. For example, an array containing
100.5 cycles of the IF waveform can be copied and concatenated to form a new phase−continuous IF
waveform array which contains 201 cycles.

For some combinations of array size and IF frequency, it may be necessary to repeat the original IF array
multiple times to attain phase continuity. In fact, if the original array contains an irrational number of
cycles, it is impossible to arrive at an exact integer number of cycles in the repeated array. However, you
can get close and then coerce the IF frequency to the nearest quantum to get an exact integer number of
cycles. This ensures phase continuity at the expense of introducing a frequency quantization error 1. The
maximum possible frequency error introduced is inversely proportional to the size of the IF waveform
array; therefore it is possible to make the frequency quantization error arbitrarily small as long as the
array size can be arbitrarily large.

In practice, it is possible both to ensure phase continuity and keep the frequency error of the IF carrier
within a tolerance (which depends on your memory size). A large memory size allows a small frequency
error, while a small memory size can give rise to a larger frequency tolerance error.

Note  You may encounter "out of memory" errors (or "memory full" errors) even when the original
waveform is smaller than the specified maximum waveform size. To overcome this problem,
increase the frequency tolerance setting. This allows the driver to coerce to an RF frequency that
requires fewer buffer repetitions.

By default, NI−RFSG assumes that the user−specified input IQ array is phase−continuous. NI−RFSG
repeats the input IQ array as necessary to ensure phase continuity in the IF waveform after IQ−to−IF
upconversion.

30



If phase continuity is irrelevant to your application (for example, your array represents a burst signal with
a significant portion of the envelope equal to zero power), then you can disable array repetition by setting
the Phase Continuity Enabled property to FALSE. This will often save processing time and AWG
onboard memory, but does not ensure phase coherence in the IF waveform between bursts.

Note

Disabling phase continuity does not force the output waveform to be non−phase−continuous; rather
it stops the NI−RFSG driver from repeating the waveform to ensure phase continuity.

1 The term "frequency error" refers to the difference between the user−requested RF output frequency and
the actual RF output frequency of the NI 5670. The NI−RFSG driver coerces the output frequency as
close to the requested value as allowed by the "Frequency Tolerance" attribute. The absolute frequency
error in the output value of the NI 5670 is determined by the 10 MHz reference used during generation.
When using the NI 5610 onboard reference, this error is less than 50 ppb.

Resampling and Phase Continuity

Resampling can disturb phase continuity. For example, if a sine wave sampled at 4 samples per cycle, in a
4−sample long phase−continuous array, is resampled to a rate of 4.5 samples per cycle, the 4 original
samples (the rate change produces 4.5 samples, but only an integer number of samples can be returned by
the resampler) are no longer phase−continuous. Phase continuity is only preserved if an integer number of
samples in the original array becomes an integer number of samples in the resampled array.
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Figure 2. A sine wave with its frequency coerced to be phase−continuous at an integer sample rate.
In graph A, no resampling is needed. In graph B, a single cycle has been resampled from 4 (circles) to

5 (squares) samples per cycle.

Address this using a similar approach to that mentioned above: repeat the original array. If the original
array is copied and concatenated, there are now 8 samples in the new phase−continuous array. The
frequency content of the new array is exactly the same as the frequency content of the original array. If
resampling is performed from 4 to 4.5 samples per cycle, the 8 samples becomes 9 samples. Since 9 is an
exact integer, phase continuity will be preserved. This strategy is shown in some NI−RFSG examples.

Figure 3: Both sample rates are phase−continuous on two cycles.
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Power Level Adjustment

NI 5670 output signal power level is a result of both the NI 5610 upconverter module gain settings and
the the NI 5421 AWG module IF waveform power. The NI−RFSG driver transparently adjusts both
devices to achieve an actual RF output power level that is within specified tolerances of the power level
requested using the Power Level property. Hardware settings are selected by NI−RFSG to optimize
linearity and noise floor performance.

This section describes the components adjusted to reach the specified amplitude, and scenarios describing
how these adjustments are combined.

Note  See the NI 5670 Specifications, installed at Start»Programs»National
Instruments»NI−RFSG»Documentation for guaranteed output power ranges.

Adjustment Components

The NI 5610 upconverter module adjusts NI 5670 output signal power in increments of 1 dB by
asserting up to 121 dB of onboard IF and RF attenuation. The NI 5610 has a nominal gain of
20 dB and a maximum output power level specified at 13 dBm linear power minimum (at room
temperature). (Absolute maximum power is a function of frequency and is unit−dependant; refer
to the Allow Out of Specification User Settings property.) Attenuation settings versus frequency
and temperature are determined during calibration.

• 

The NI 5421 AWG module provides fine resolution signal power adjustment by tuning the main
digital−to−analog converter (DAC) attenuation. This fine−tuning of the main DAC attenuation is
performed by the gain DAC. The NI 5421 has two signal paths, the Direct Path and the
Low−Gain/High−Gain Amplifier path. NI−RFSG automatically selects a path and DAC
attenuation setting based on signal power requirements. As progressively more attenuation is
required, these components are adjusted as follows:

5421 Direct Path
The NI 5421 Direct Path optimizes NI 5670 linearity for high power level signals. The
Direct Path removes the NI 5421 analog filter, attenuation sections, and amplifiers from
the signal path, yielding an output signal with the lowest possible distortion and flat
frequency response. The NI 5421 AWG Direct path provides a 1 Vpk−pk full−scale output
into a 50 Ohm load with no offset (approximately +4 dBm output power into a 50 Ohm
load). 3 dB of analog signal attenuation is available (in increments of less than 0.02 dB)
by adjusting the NI 5421 main DAC attenuation. Attenuating the DAC output signal
allows very fine resolution control over signal power while always maintaining the
dynamic range of the DAC, ensuring no bits are lost from the digital representation of the
waveform. This path is used when attenuation levels of 3 dB or less are required from the
NI 5421.

1. 

High−Gain/Low−Gain Path
The Low−Gain/High−Gain Amplifier Path offers much greater attenuation than the
Direct Path, and allows NI−RFSG to set the and amplifiers onboard the NI 5421 AWG
module. The Low Gain/High Gain amplifier path offers up to approximately 35 dB of
attenuation.

Tip  Main DAC attenuation adjustment is still used for fine power level control

2. 

• 
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(within 0.02 dB) and offers up to additional 3 dB of output attenuation.
Digital Waveform Scaling
If more than approximately 38 dB of attenuation is required from the NI 5421, the
NI−RFSG driver uses the Low−Gain/High−Gain Amplifier Path with maximum
attenuation, and additionally modifies the digital waveform such that it does not use the
full−scale output voltage of the DAC. Scaling the digital waveform this way potentially
decreases the dynamic range and thus the signal−to−noise ratio, but offers more than
30 dB of attenuation in addition to that asserted by the Low−Gain/High−Gain Amplifier
path. Scaling has no observable effect on NI 5670 signal−to−noise ratios, however,
because NI−RFSG only scales the digital waveform at power levels (< −135 dBm
typical) where other components dominate the signal−to−noise ratio. The NI−RFSG
driver performs scaling on both sine waves and arbitrary waveforms as required.

3. 

Tip  Attenuator hold mode avoids using the NI 5421 Main Path. This improves accuracy at low power
levels (< −80 dBm, depending on frequency) but decreases frequency tuning speeds. Refer to the
Attenuator Hold property help for details.

Refer to the NI Signal Sources Help, located at Start»Programs»National
Instruments»NI−FGEN»Documentation, for complete information about NI 5421 output paths.
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NI 5421 Analog Paths Block Diagram

Note  Refer to the NI Signal Sources Help, located at Start»Programs»National
Instruments»NI−FGEN»Documentation, for complete information about NI 5421 output paths.

Adjustment Scenarios

There are three ways the NI−RFSG driver may achieve the output power level specified in the Power
Level property. NI−RFSG automatically selects the scenario which optimizes linearity and noise floor
performance while achieving the requested power level.

Refer to the figure below and the table on the following page for descriptions of NI 5670 power level
adjustment scenarios. A represents the maximum attenuation of the NI 5610 upconverter.

NI 5670 Power Level Adjustment

Approximate
Signal Power

Adjustment Scenario

> −85 dBm

The NI 5610 upconverter attenuators are asserted in 1 dB steps to approximate output
power. The NI 5421 is configured to use the Direct Path and the main DAC
attenuation is adjusted to fine−tune signal power to the specified level. The full
dynamic range of the NI 5421 DAC is used, and noise and intermodulation distortion
are minimized.

−90 dBm
to
−130 dBm

The NI 5610 upconverter attenuators are fully asserted and the NI 5421 is configured
to use the Low−Gain/High−Gain Amplifier Path with appropriate attenuation. The
attenuation of the main AWG DAC is still adjusted to fine−tune signal power to the
specified level. Intermodulation distortion is negligible because distortion products are
below the noise floor.
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< −130 dBm

The NI 5610 upconverter attenuators are fully asserted and the NI 5421 is configured
to use the Low−Gain/High−Gain Amplifier Path with maximum attenuation. In
addition, the digital waveform is scaled such that it does not use the full−scale output
voltage of the DAC. Scaling the digital waveform has no observable effect on
dynamic range, which at these power levels is dictated by the thermal noise floor.

Note  All ranges are approximations. See the NI 5670 Specifications, installed at
Start»Programs»National Instruments»NI−RFSG»Documentation for guaranteed output power
ranges.

Attenuator Hold Mode

Use attenuator hold when you need to keep the power monotonically decreasing while preserving the
same power error at the specific frequency setting.

The attenuator hold feature allows the user to adjust the output level in fine decrements without switching
the internal attenuators on the NI 5670. To achieve this, the NI−RFSG driver sets the NI 5610 to the
attenuation corresponding to the highest desired power level in a sweep (refer to the Power Sweep
example) and then adjusts output signal amplitude by scaling the IF digital waveform such that it does not
use the full scale of the DAC onboard the NI 5421 AWG. Scaling the digital waveform potentially
decreases the dynamic range and thus the signal−to−noise ratio. Tuning speed may also increase slightly.

When attenuator hold mode is enabled, the NI−RFSG driver only allows signal power settings such that
the DAC always uses at least 4 bits. This allows at least 55 dB attenuation below max power if the
temperature is kept within +/− 20 degrees Celcius.

To configure attenuator hold complete the following steps:

Open a session to the instrument.1. 
Configure the Attenuator Hold Max Power property. This setting specifies the highest power
level on your sweep.

2. 

Specify the power level of the output signal (P).3. 
Enable attenuator hold mode using the Attenuator Hold Enabled property. The attenuators are set
at commit time.

4. 

Initiate signal generation.5. 

Note  Generation starts at the specified power level P, but the attenuators are set in such a way that
the requested maximum power can be achieved only by incrementing the digital waveform.

Output Enable

You can disable signal output at the NI 5610 upconverter module front panel SMA connector labeled RF
OUTPUT using the Output Enable function. You can change the output enable state at any time during
waveform generation and the generation continues on internally.
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Refer to the Configure Output Enabled property for more information on using output enable.

Note  Output enable uses mechanical relays and attentuators to switch between the enabled and
disabled states. When you change a setting that results in asserting new relay or attenuator settings,
bouncing of the electromechanical components may interrupt the output signal for up to 10 ms.

Start Triggers

Start triggers initate signal generation. When a start trigger is received, the RF output signal begins to
generate continuously as shown in the figure below. Received triggers are ignored until niRFSG Initiate is
called. Triggers received after signal generation has started are ignored.

NI 5670 Start Trigger Model

NI 5670 start triggering is controlled by the NI 5421 AWG module. NI 5670 start triggers are configured
using the niRFSG Start Trigger Type property.

Note  The NI 5610 upconverter module adds an additional delay, typically 1200 ns, to the delay
from the start trigger to waveform out that is specified for standalone use of the NI 5421. Refer to
the NI−FGEN Online Help for more information about NI 5421 triggering.

Start Trigger Options

The following three options are available for the NI 5670 start trigger:

None−−Signal generation starts immediately upon execution of the niRFSG Initiate VI. No
trigger is necessary. This is the default configuration in NI−RFSG.

1. 

Software−−After initiation, signal generation does not begin until a software trigger is received.
Call the niRFSG Send Software Edge Trigger VI to send the software start trigger.

2. 

Digital Edge−−After initiation, signal generation does not begin until a digital edge is received.
Specify the digital edge source by setting the Digital Edge Start Trigger Source property to one of
the following options:

Digital Edge Sources

PFI <0..3>♦ 
PXI_TRIG <0..7>♦ 
PXI_STAR♦ 

3. 
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Tip  Sending a software trigger when the Start Trigger Type property is set to Digital
Edge also starts signal generation. This allows use of a software timeout to avoid
leaving the instrument in a waiting state if the digital edge is never received.

The following figure depicts the possible software trigger sources for the NI 5421 AWG module:

NI 5421 Start Trigger Sources

Advanced Topics

This section contains information for the advanced user who wants to optimize performance by more
deeply understanding the NI 5670.

NI 5670 Thermal Management

The NI 5610 operates at an internal temperature of approximately 45 °C (113 °F) under conditions of
proper airflow and 25 °C (77 °F) ambient temperatures. The NI 5610 module front panel may reach
approximately 39 °C (99 °F) during normal operation.

Caution  Allow time for the NI 5610 upconverter module to cool before removing from the
PXI chassis. Use caution when handling a recently used module.

After the warm up period, the temperature of the NI 5670 hardware is typically stable. However, if the
temperature does vary due to external factors such as ambient temperature or cooling airflow changes,
NI−RFSG automatically applies thermal correction to maintain output signal power within specified
tolerances.
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Warmup

NI recommends warming up the NI 5670 for 30 minutes before operation.

Note  Warmup begins when the operating system and the NI−RFSG driver have fully loaded. Driver
loading can be verified by running a self−test in MAX or calling niRFSG Self Test.

NI 5610 Temperature Monitoring

The internal temperature of the NI 5610 can be queried by the user, and is additionally monitored by two
separate automatic processes. The NI−RFSG software monitors the temperature for the purpose of
adjusting the output level to correct for changes in temperature. Separately, a state machine built into the
hardware monitors the temperature of the RF enclosure for thermal shutdown conditions which could
damage the equipment.

User Querying

Querying the value of the upconverter temperature property returns the internal temperature of the
NI 5610.

Note  The temperature sensor queried by the upconverter temperature property is within the NI 5610
RF enclosure and contains an internal clock that is activated when it is enabled. This clock can cause
low−level close−in phase noise spurs, usually below −70 dBc and varying from unit to unit. For this
reason it is highly recommended that the temperature sensor not be continuously queried in order to
maintain a cleaner spectrum.

Automatic Thermal Correction

The yaw, or uncorrected gain drift, of the NI 5610 upconverter module is approximately 0.05 dB per °C.
The NI−RFSG software corrects for this temperature drift periodically. This thermal correction can be
disabled using the Thermal Correction Enabled property.

Each time an output signal is requested the NI−RFSG software checks the upconverter temperature and
adjusts the attenuation and the full−scale IF level as necessary to output the requested power level within
specified accuracy. After signal generation has started, the NI−RFSG software periodically checks the
temperature of the NI 5610. If the temperature has changed more than 0.5 °C from when the generation
started, the NI−RFSG software readjusts the attenuation and/or the IF level to maintain a constant output
level.

Assuming proper warmup, the temperature of the NI 5670 hardware should not change during operation.
If the temperature does change significantly due to external factors such as ambient temperature or
cooling airflow changes, it is possible that having thermal correction enabled may cause transient noise in
the RF output signal when the correction is being applied.

For some applications this transient caused by the attenuator switching during level adjustment may not
be acceptable. You can disable thermal correction for applications that are sensitive to this transient by
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setting the niRFSG Thermal Correction Enabled property to DISABLE. When termal correction is
disabled, NI−RFSG only readjusts the output level when you stop and restart signal generation.

You can disable operating temperature monitoring using the Thermal Correction Enabled property.
Enabling thermal correction (default) may cause noise on the output signal when the correction is being
applied, but ensures constant output power despite temperature fluctuations.

Automatic Thermal Shutdown Monitoring

Once the NI−RFSG driver has loaded, the RF enclosure is powered on. From that time onward, circuitry
on the NI 5610 continuously monitors the temperature. It will power off the RF enclosure before the
temperature gets high enough to damage the NI 5610. If this happens the NI−RFSG software will return
an error and you must reset the NI 5610 in order to restore power to the RF enclosure. You can reset the
NI 5670 by right−clicking both hardware modules in MAX and selecting Reset Device, or by calling
niRFSG Reset Device VI.

Note  The NI 5610 will be warm to the touch during normal operation. It should never reach a
temperature high enough to cause thermal shutdown unless the fan or vents on the PXI chassis are
blocked, or the filters on the fans are excessively dusty. If you get a thermal shutdown error, make
sure the filters are clean and that you have a clear path for airflow through your PXI chassis.

Software Equalizer

Equalization is the process of adjusting the frequency content of the signal or the frequency response of
the signal path so that the effective gain is independent of the frequency. In terms of frequency response,
a flat response or constant gain versus frequency is desirable for highest modulation quality in the
generated signal.

The NI 5610 upconverter module introduces small variations in the IF gain/phase response of the RF
Vector Signal Generator. These variations are introduced by the anti−imaging filters that are used in
performing an image−free upconversion.

Plots of the typical magnitude response of the NI 5610 upconverter with and without software
equalization enabled are shown in the figures below.
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Typical Passband Response of the NI 5610 Upconverter Module With and Without Equalization

As can be seen from the typical response, there is +/− 2 dB max gain variation between the center of the
band and the outer edges of the passband. This variation results in degradation of the modulation quality
for wide−bandwith signals generated using high symbol rates (> approx. 500 Kilosymbols/Second
(kS/s)).

The variation in the frequency response can be reduced by equalizing the digital data stream to
compensate for the passband response of the NI 5610 uponverter. This equalization can be performed via
a digital filtering operation by the NI−RFSG driver software.

The equalizer filtering uses coefficients that are determined and stored in the onboard nonvolatile
memory during calibration.

Note  The equalizer performs both gain and phase compensation to get the best response. For
simplicity, only the gain response is discussed here.

The property that controls the equalization is Digital IF Equalization Enabled. This property can be used
to enable/disable software equalization or to query the enabled/disabled state of the software equalizer.

When enabled, software equalization improves the modulation quality for wider real−time bandwidth (>
500 kHz) signal generation.
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Tip  Software equalization is not recommended for narrow−bandwidth signal generation. Software
equalization realizes little to no improvement in narrow−bandwidth signals, but still requires
additional computation time for digital filtering.

Symbol Rate
Recommended
Equalization

Comments

<=500 kS/s), Filter
Alpha < 0.25

Disabled (default)

Because the occupied bandwidth is 500 kHz or less,
there is little performance gain from turning on
equalization. Disabling equalization (default) is
recommended for faster throughput.

>500 kS/s Enabled
The modulation quality (Error Vector Magnitude) is
improved by enabling equalization for wide
bandwidth (> approx. 600 kHz) signals.

For faster test times with equalization ON, you may consider saving a digital waveform that has been
pre−equalized so that the digital filtering operation,and the associated computation time, is done once as
opposed to every time the same waveform pattern has to be generated. There are low level tools available
to extract the equalization filter coefficients stored in the onboard nonvolatile memory. Please refer NI
technical support if you need to access these tools.

Other considerations:

The factory determined equalizer filter coefficients are valid for 25 °C +/− 10 °C. For operation outside
this temperature range, it is recommended that the equalizer filter be determined under the operating
environment. Please refer to ni.com/examples for example code that allows you to determine the filter
coefficients using a digitizer.

You may want to calibrate and compensate the entire signal chain on a system basis for some advanced
applications, such as the following:

custom equalizer filtering operations that take into account not only the passband response of the
NI 5610 upconverter but an external signal conditioning device such as a filter or amplifier

• 

determining equalizer coefficients in the field for ambient temperature outside the
25 °C +/− 10 °C range

• 

In cases like these, NI recommends disabling the software equalization (by setting the Digital IF
Equalization Enabled property to Disable) and applying the equalization filter in your application
program before passing the data to NI−RFSG. National Instruments application development
environments, including LabVIEW and LabWindows/CVI, have built−in tools for digital filtering
operations to assist with this task.
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Noise Floor

Noise floor is the measure of the noise density (dBm/Hz), or the noise power in a 1 Hz bandwidth. Noise
can be classified into several different types: Shot noise, thermal noise, flicker noise, burst noise,
quantization noise, and avalanche noise. Thermal noise is dominant noise source of the NI 5610. Thermal
noise is caused by the random fluctuations produced by thermal agitation of bound charges.

The noise due to a matched resistive load can be expressed as:

Ni = kTB Watts

where k is Boltzmann's Constant (k = 1.38 x 10−23J/K), T is the resistor temperature in degrees Kelvin,
and B is the bandwidth in Hertz. If B is set to 1 Hz, then Ni is equal to the output noise density in W/Hz.
For the system shown in the following figure, the output noise floor is the combination of the input noise
multiplied by the gain or loss of the system plus the internal noise of the system, Nn:

NI 5670 Noise Floor

The internal noise of a system is therefore:

The noise factor (F) of a system is a measure of how noisy a component or system is. The noise factor is
defined as:
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If N i is equal to kTB then,

No = FGkTB (Watts)

No(B=1) = 10log(1000(FGkT)) (dBm/Hz)

Therefore, the output noise floor of the NI 5610 is not only dependent on the noise generated by the
internal components, but it is also dependent on the noise generated by the source and by system settings.
The noise floor of the PXI−5670 is dominated by the NI 5610. This is because the NI 5610 utilizes a
superheterodyne architecture, and a significant amount of gain is located in the broadband output section
(refer to the 5610 block diagram). As a result, care should be taken in non−frequency−selective
applications such as testing a broadband device with a broadband detector, as noise power is integrated.
Integrated noise power can be calculated using the following formula:

No = No(dBm/Hz) + 10logB

where B is equal to 2.7 GHz (if no external filter is used) and No is the noise floor spectral density. With
the NI 5670 set to minimum output power the noise power density at the output is −158 dBm/Hz. When
the NI 5670 is set for power levels greater than 5 dBm the typical noise power density at the output is
−152 dBm/Hz. The following table shows typical output noise power density for several NI 5670 output
power level settings:

Power Level (dBm) Typical Noise Floor (dBm/Hz)

−57 −158

−50 −157

−40 −154

−30 −147

−20 −140

−10 −130

0 −120

10 −110

Typical Noise Floor versus Power Levels at 2 GHz
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Third−Order Intercept

Third−order intercept point is a figure of merit of the degree of linearity of a system. Third−order
intercept point is a calculated number derived from a two−tone intermodulation test. Typically, two tones
of the same power level and of different frequencies are applied to the input of a device. At the output of
the device not only will there be the two desired tones, but there will also be distortion products. These
distortion products are a result of nonlinearities within the device. Consider the following equation to
represent the input signals:

A nonlinear device will have an output response that can be expressed by:

Where the  coefficients represent the gain and the degree of nonlinearity within the device. The x2

terms represent the second−order distortion terms and the x3 represents the third−order distortion terms,
and 1x(t)represents the desired output.

Plugging x(t) into yt results in the following distortion factors:

Frequency Distortion Order Typical Output Power Level

0 (DC offset) Second

Second

Second

Second

Second

Third

Third

Third

Third

Third

Third

The terms of most interest are  and , because these are closer into the carrier and difficult to

filter off. For broadband systems such as CATV it is important to consider all the terms that fall within its
bandwidth. A plot of the desired output signal frequency versus input power is shown in the following
figure. Also shown in this plot are the second−order distortion level and the third−order distortion level
power levels versus input power.
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Second− and Third−Order Intercepts

The output second−order intercept point (OIP2) and the output third−order intercept point (OIP3) occur
where the second−order line and third−order line intersect the desired output signal respectively. If A1 is
set equal to A2, and each one is increased 1 dB, then the third−order distortion products will increase 3 dB
for every 1 dB increase in output power. The second−order distortion products will increase 2 dB for
every 1 dB increase in output power. Therefore, based on a two−tone intermodulation test the output IP3

can be calculated using the following formula:

OIP3 = Pout (dBm) + .5IMD3rd(dBc)

OIP2 = Pout (dBm) + IMD2nd(dBc)

The third−order intercept is dependent upon power levels. The following table is a summary of the typical
performance:

Frequency (MHz)   −20 dBm/tone   −6 dBm/tone   5 dBm/tone

100 86 dBc 78 dBc 54 dBc

1000 86 dBc 86 dBc 54 dBc

2000 86 dBc 86 dBc 50 dBc

2700 86 dBc 82 dBc 46 dBc

Typical Third−Order Distortion Products (dBc)

As the output power level is increased, the third−order intercept point increases, except for power levels
above −3dBm/tone. Beyond this power level there is a step reduction in TOI as shown in the table above.
The second−order intercept point behaves in a similar manner. This step change above −3 dBm/tone is
caused by the architecture and attenuator locations of the NI 5610.
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Dynamic Range

Dynamic range is the range between the minimum detectable signal, in this case the noise floor, and the
−1 dB compression point, as shown in the following figure:

Dynamic Range

Dynamic range is expressed with the following equation:

DR (dB) = P1dB(dBm) – Noise Floor (dBm/Hz)

Another term often used to describe the dynamic range is the spurious free dynamic range (SFDR). In the
traditional sense of an amplifier or transmitter, this is the level at which the IMD products are equal to the
noise floor. Therefore, the input signals are adjusted such that the difference between the desired signals
and the noise floor would be equal to the difference between the desired signals and the spurs. The
following figure is a graphical representation of the spurious free dynamic range:
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Spurious−Free Dynamic Range

The spurious free dynamic range can be calculated from the third order intercept point and the second
order intercept point using the following equations:

SFDRTOI = 2/3(OIP3 – Noise Floor)

SFDRSOI = .5(OIP2 – Noise Floor)

Using the NI 5610 as a stand alone unit, to maximize the SFDR follow the same procedure used to
maximize the third order intercept point which is to minimize RF attenuation.

When using the NI 5610 in conjunction with the NI 5421 as a calibrated unit, the spurious free dynamic
range for a two−tone signal is the difference between the desired tones and the intermodulation levels.
This number can be calculated from the TOI and SOI using the following equations:

IMDTOI = 2(OIP3 –Pout)

IMDSOI = OIP2 – Pout

Output Power (dBm) Noise Floor (dBm/Hz) TOI Products (dBc)

−20 −140 −86

−6 −126 −86

5 −115 −54

Typical NI 5670 Performance @ 2GHz
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Frequency Tuning Times

Many factors contribute to NI 5670 frequency tuning times. One factor is the amount of time required for
the upconverter PLLs to lock to a new frequency. Because the NI 5670 is an AWG−based vector signal
generator, tuning times must also account for the times that it takes to configure the NI 5421 AWG
module. This time potentially includes recalculating and uploading a new waveform to the NI 5421 AWG
module onboard memory.

NI 5670 overall tuning time is the longer of the NI 5610 upconverter module and NI 5421 AWG module
tuning times. If the NI 5670 is tuned in steps of 1 MHz (when using signal bandwidths >10 MHz), or
steps of 5 MHz (when using signal bandwidths >=10 MHz), a new waveform is not written to the AWG
module and AWG module settling time is 0 ms.

NI 5610 Upconverter Frequency Tuning Time

When the frequency is changed in a phase−locked loop system, the signal loses lock on the initial
frequency and achieves lock on the new final frequency. The signal takes time to settle to within some
frequency tolerance of the final frequency. Furthermore, the tolerance may be set to as a ratio of the step
frequency size, for example in GSM the signal must settle to less then 2 ppm of the frequency step size in
about 860 µs. Our discussion will define tuning speed as the time required by the signal to lose lock on
one specific frequency and jump to another specific frequency within a specified frequency tolerance.

The NI 5610 front panel ACTIVE LED indicates hardware PLL lock status. The ACTIVE LED indicator
turns green when 5 consecutive pairs of comparison clock cycles are within 15 ns of each other, so it is
possible that the signal has not yet settled to within the specified tolerance when the hardware lock
ACTIVE LED indicator comes on. To provide a clearer understanding of the hardware lock times, a table
of NI 5610 phase−locked loop lock times for various tuning step sizes is provided below.

Frequency Tolerance
Step Size

10 MHz 100 MHz 1000 MHz

10 kHz 2 ms 6 ms 12.5 ms

1 kHz 4 ms 12 ms 17.5 ms

100 Hz 12 ms 18 ms 25 ms

NI 5610 Upconverter−Only (Sine Wave Mode) Tuning Times

The NI 5610 upconverter module tunes in steps of 1 MHz (when using signal bandwidths >10 MHz), or
steps of 5 MHz (when using signal bandwidths >=10 MHz). NI 5610−only tuning times are specified in
the table above.

Sine Waveform Mode

In sine waveform mode, the NI−RFSG driver automatically creates the phase−continuous sine waveform
needed for the specified frequency.
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Tuning Speed Factors

In sine waveform mode, the factors that contribute to the tuning time are:

Frequency step size (desired frequency − previous frequency).

The 5610 has different tuning times for various frequency step sizes.

1. 

Requested RF output frequency.

Depending on the requested RF output frequency the waveform size varies (see the phase
continuity section for details). As the size increases, more time is needed to compute and upload
the waveform to the NI 5421 AWG module onboard memory.

2. 

Frequency tolerance setting.

Increasing the frequency tolerance allows the NI RFSG driver to approximate the desired
frequency using a smaller number of waveform cycles, decreasing tuning time (see the phase
continuity section for details).

3. 

Automatic thermal correction.

Thermal monitoring begins with signal generation and continues until generation is stopped. The
process of starting and stopping automatic thermal correction adds somewhat to the tuning time.

4. 

Typical tuning times

Typically, the largest delay in tuning to a new frequency is the time it takes the NI 5610 to lose lock on
the current frequency and acquire lock on the new frequency. Depending on the step size, the NI 5610
takes different amounts of time to lock to new frequencies.

The following figure illustrates typical NI 5670 sinewave tuning times for different step sizes:
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Typical NI 5670 Sinewave Tuning Times
Thermal Correction Disabled
Frequency Tolerance = 50 Hz

Previous Frequency = Desired Frequency + Step Size

Upconverter tuning times are not a factor when the NI 5610 upconverter module does not have to be
reconfigured, in which case the NI 5670 tuning time is dominated by the time it takes to compute and
upload the sine waveform to the NI 5421 onboard memory.

The following graph depicts NI 5670 sinewave tuning times for small frequency step sizes:
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Typical NI 5670 Sinewave Tuning Times −− Small Frequency Steps
Thermal Correction Disabled
Frequency Tolerance = 50 Hz
Previous Frequency = 50 MHz

Maximum tuning time

The NI 5670 requires the maximum tuning time when ALL of the following conditions are true:

The frequency step size is > 2 GHz, AND1. 
The frequency tolerance is at minimum setting (1 Hz), AND2. 
The desired RF output frequency requires a large waveform.3. 

The following graph depicts the NI 5670 sinewave tuning times under worst case conditions:
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Worst Case NI 5670 Sinewave Tuning Times
NI 5610 step size: > 2 GHz
Frequency Tolerance: 1 Hz

Previous Frequency: 2.5 MHz

Tips  The following measures can decrease sinewave tuning times:

Disable automatic thermal correction if your application does not require it.1. 
Increase the frequency tolerance as much as allowed by your application.2. 
Change your frequency in 5 MHz step sizes so that recalculation of the sine waveform is not
required.

3. 

Arbitrary Waveform Mode

In arbitrary waveform mode a user−specified complex IQ baseband signal is written to the driver. Then,
depending on different parameters, the NI−RFSG driver upconverts the signal to IF and uploads it to the
NI 5421 AWG module onboard memory.

Tuning Speed Factors

In arbitrary waveform mode, the following main factors affect NI 5670 tuning time:

Waveform size.

The bigger the waveform the longer it takes to be recalculated and uploaded to NI 5421 AWG
module onboard memory. Increasing the size of the waveform increases required tuning time in a
linear fashion.

1. 
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Digital IF equalization.

The process of digitally equalizing the waveform is very computationally demanding and adds to
tuning times.

2. 

Phase continuity. If this property is enabled, NI−RFSG may repeat the IQ waveform before
upconverting it to IF in order to ensure phase continuity. Repeating the IQ waveform changes the
size of the IF waveform and, as noted, increases the NI 5670 tuning time. The final IF waveform
size depends on the frequency tolerance, desired frequency, and input size.

3. 

Desired frequency.4. 

Available RAM.

Large waveforms require a large amount of RAM. If sufficient RAM is unavailable, the system
uses virtual memory, which dramatically increases execution times.

5. 

Typical Arbitrary Waveform Tuning Times

The following figures illustrate NI 5670 tuning times for an arbitrary waveform of 1 million samples with
digital IF equalization disabled and enabled, respectively:
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NI 5670 Arbitrary Waveform Tuning Times
Waveform Size: 1 Million Samples

NI 5610 step size: > 2 GHz
Phase Continuity: Disabled

Digital IF Equalization: Disabled

NI 5670 Arbitrary Waveform Tuning Times
Waveform Size: 1 Million Samples

NI 5610 step size: > 2 GHz
Phase Continuity: Disabled

Digital IF Equalization: Enabled

Tips  The following measures can decrease arbitrary waveform tuning times:

For signal bandwidths < 600 kHz, disable digital IF equalization.1. 
Disable phase continuity if your application does not require a phase−continuous
signal.

2. 

Write large waveforms in chunks to avoid exceeding RAM capacity and using
virtual memory. NI−RFSG examples demonstrate how to write waveforms in
chunks.

3. 

Phase−Locked Loop Bandwidth

The phase−locked loop (PLL) bandwidth characterizes the loop dynamics such as tuning speed, stability,
and phase noise shaping. When the PLL bandwidth is designed for X Hz, then it occurs at X Hz after from
the center of the carrier signal, as shown in the figure below. The region of frequency between the carrier
and the PLL BW is termed "inside the loop", and the region higher then the PLL bandwidth is termed
"outside the loop".
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PLL Bandwidth

Tuning speed is increased as the bandwidth is increased, and vise versa. PLL theory states that the phase
noise of the LO signal maybe broken into 2 components; the phase noise of the tuning oscillator and the
noise from the loop components with the reference signal inclusive. The tuning oscillator phase noise
dominates the region outside the loop, while the regiod inside the loop is dominated by the loop
components.

There are 2 possible settings for loop bandwidth: LOW and HIGH, as shown in the following table. When
signal bandwidth is set higher then 10 MHz, the only availabe loop bandwidth option is LOW. To change
the loop bandwidth settings, change the signal bandwidth to greater then 10 MHz (for LOW loop
bandwidth), and less then or equal to 10 MHz (for HIGH loop bandwidth).

Loop Bandwidth Setting Use

High Optimizes phase noise <=10 kHz offset from the carrier

Low For real−time bandwidths >10 MHz, this is the only available setting

Spurs

There are several different categories defining the spurious behavior of the NI 5610. The first category are
spurs occuring below 2.7 GHz that are independent of the input signal. All spurs that fit this criteria are
less than −80 dBm.

Spurs due to intermodulation distortion are dependent on the drive and change as the drive level changes.
The following equation predicts how the intermodulation distortion products will change with output
power:

IMDTOI = 2(OIP3 –Pout)
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IMDSOI = OIP2 – Pout

It is important to note that the third order intermodulation distortion, which is the difference between Pout

and the distortion signals in dB or dBc, degrades by 2 dB for every 1 dB increase in Pout for the third
order distortion terms, and degrades by 1 dB for every 1 dB increase in Pout for the second order terms.

The second category of spurs are those that are less than 2.7 GHz and are dependent on the input signal,
but not within +/− 10 MHz of the desired output signal. All spurs falling in this category are less than
−80 dBc, except for one, which is about −60 dBc. The output frequency for this spur can be determined
by using the following equation:

fspur = 3225 − fout − fin

where fspur, fout, and fin are in MHz.

NI 5610 Output Frequency Dependent Spur

Next are the spurs that are within +/− 10 MHz of the carrier. These spurs are the result of signals
modulating one of the LOs. These spurs should be below −50 dBc for frequencies less than 1 kHz and
better than −60 dBc for frequencies between 1 kHz and 2 kHz. Beyond 2 kHz spurious levels are less than
−70 dBc.

The last category of spurs are those greater than 2.7 GHz. There is a LO spur that occurs at 2.88 GHz and
at multiples of 2.88 GHz. These spurs are less than −80 dBm. As part of the architecture of the NI 5610
there is a broad tuning local oscillator (LO) that tunes over the range of 3.2 GHz to 5.9 GHz. The
frequency of this LO is always about 3.2 GHz greater than the output signal.

When the LOCAL OSC OUT 0 connector on the NI 5610 front panel is disabled, the LO leakage at the
RF OUT connector is typically less than −80 dBm for output frequencies greater than 100 MHz. For
output frequencies greater than 100 MHz, the LO leakage at the RF OUT connector is dependent on the
filters in the output section and can be as great as −35 dBm.
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Note  At frequencies greater than 100 MHz, the LO level is affected by the attenuators in the RF
signal chain.

When the LOCAL OSC OUT 0 connector on the NI 5610 upconverter module front panel is enabled, LO
leakage is about −45 dBm for output frequencies above 100 MHz. For frequencies below this, LO leakage
is dependent on the filters in the output section and on the output power setting. However, even with the
NI 5670 output power set to the minimum level, the LO leakage at the RF OUT front panel connector
(with the LOCAL OSC OUT O connector enabled )could be as great as −40 dBm.

This section does not address harmonic−related spurs.

Understanding Calibration Correction

The NI 5421 and the NI 5610 are calibrated individually, and the uncertainty due to matching the two
devices is taken into consideration when specifying power level accuracy of the NI 5670.

Note  Refer to the NI 5670 Specifications document, installed at Start»Programs»National
Instruments»NI−RFSG»Documentation, for complete specifications.

This section discusses the three areas of NI 5610 calibration: IF passband calibration, RF flatness
calibration, and temperature coefficient determination.

IF Passband Calibration

Intermediate Frequency (IF) passband flatness refers to the flatness, or variation, in power level over
frequency in the 20 MHz input band of the NI 5610. IF flatness is not a function of the output frequency
of the NI 5610, but rather of the internal filtering of the NI 5610.

There are six available IF attenuation levels on the NI 5610, including the 0 dB or no−IF−attenuation
level. These six IF attenuation levels are characterized at calibration for each individual NI 5610 module.
The calibration coefficients are saved into the onboard nonvolatile memory of the module. These
calibration coefficients are used in determining the IF gain at a specific attenuation setting and specific IF
frequency offset.

RF Flatness Calibration

Radio Frequency (RF) flatness refers to the variation in NI 5610 gain versus frequency over the specified
output bandwidth of the NI 5610. RF flatness is a function of the frequency to which the local oscillator is
tuned. The overall gain of the NI 5610 thus depends on both the input IF frequency and the output RF
frequency.

There are 71 calibrated RF attenuation levels available on the NI 5610, including the no−RF−attenuation
level. Each level is characterized at calibration for each individual NI 5610 module over the entire
frequency range. The calibration coefficients are saved into the onboard nonvolatile memory of the
module. These calibration coefficients are used (along with tempterature calibration and IF calibration

59



coefficients) in determining the RF gain of the NI 5610 for a specific IF and RF frequency setting and a
specific module temperature.

Temperature Calibration

The NI 5610 is thermally compensated to account for changes in gain with hardware temperature. The
uncompensated gain of the NI 5610 upconverter module drifts at a rate of approximately 0.05 dB per
degree Celcius.

To compensate for this drift, calibration coefficients are saved into the onboard nonvolatile memory of
the module during calibration. These coefficients are used by NI−RFSG to compensate for variations in
gain and frequency−dependent effects resulting from temperature changes.

NI 5670 Power Requirements

Each module of the NI 5670 (NI 5610 upconverter and NI 5421 AWG) interfaces to the PXI backplane
via a separate PXI bus connector. The NI 5610 upconverter module occupies two PXI Slots but interfaces
to the PXI backplane via its leftmost occupied slot, while the NI 5421 interfaces via its occupied
PXI Slot. Each of the devices is constrained in power consumption to the maximum power specified by
the PXI standard. While the NI 5421 is limited in power consumption to what is available to one
PXI Slot, the NI 5610 has the total power of two slots available to it, unless otherwise limited by the
connector pin−rating per PXI standard.

Note  Refer to the NI 5670 Specifications document, accessible at Start»Programs»National
Instruments»NI−RFSG»Documentation, for detailed information about NI 5670 power
consumption.
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Troubleshooting
This section contains troubleshooting information for common NI 5670 measurement and setup problems.

Troubleshooting Modulation Quality

When using modulation quality measurements such as Error Vector Magnitude (EVM) and Modulation
Error Ratio (MER), a number of parameters can influence the measurements significantly. Two errors
that can affect the signal quality are:

Failure to achieve carrier lockno recognizable constellation diagram or very poor, erratic EVM
and MER measurements

1. 

Carrier lock achieved, but poor EVM, MER measurements2. 

To ensure acceptable modulation quality, complete the following steps:

Verify the carrier frequency settings on the signal generator (transmitter) and signal analyzer
(receiver). If these settings are out of tolerance —− either by incorrect settings or by correct
settings but poor tolerance on one of the devices −— carrier lock fails. Typically, the carrier
frequency must have a large error to have any impact on the signal.

1. 

Carrier offsets have no effect until the offset is either outside the lock range, or the signal is
outside of the receiver bandwidth. In figure 1 below, a 30 kHz carrier offset has moved part of the
signal outside of the receiver bandwidth. In this case, you can either tune the carrier, or use a
wider receiver bandwidth setting.
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Figure 1. Incorrect Carrier Offset Settings

Figure 2 below shows a signal with a 100 kHz carrier offset and a bandwidth wide enough to
encompass all signal information.

Figure 2. Correct Carrier Offset Settings

Verify that the modulation type settings match on both the transmitter and receiver.2. 
Verify the symbol rates on the signal generator (transmitter) and signal analyzer (receiver). If
these rates are out of tolerance—either by incorrect settings or by correct settings but poor
tolerance on one of the devices—symbol recovery fails. Symbol rate error is more likely to have a
gross impact on the signal than carrier frequency error because symbol rate error can look like a
poor measurement.

Figures 3 and 4 below are examples of EVM plots with and without a symbol rate error.

3. 
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Figure 3. EVM with 50 Hz Symbol Rate Error

Figure 4. EVM with no Symbol Rate Error

Figures 5 and 6 below are examples of constellation plots with and without a symbol rate error.
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Figure 5. Constellation with 40 Hz Symbol Rate Error

Figure 6. Constellation with All Parameters Correctly Tuned

Verify that the signal transmission power levels and the receiver input reference levels are
consistent with each other. If the signal levels are not matched properly on the transmit and the
receive side, MER and EVM degrades due to one of the following conditions:

4. 
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The receiver (analyzer) is being over driven into nonlinear mode (saturation). To address
this, increase the receiver reference level setting. If the measurements improve, the
analyzer was being driven into saturation.

Alternately, you can reduce the generator (transmitter) power −— if modulation quality
improves, either the generator or the analyzer was driven into saturation.

1. 

Figure 7 below is a constellation plot from an overdriven receiver. To correct this error,
you can either attenuate the power entering the receiver, or increase the receiver reference
level setting.

Figure 7. Overdriven Receiver

The input is being driven with a very low power signal, and a poor signal−to−noise ratio
exists within the signal analyzer. Reduce the reference level on the analyzer. If the
modulation quality measurements improve, the full dynamic range of the analyzer was
not being utilized. Alternately, you can increase the power level of the transmitted signal
from the signal source.

2. 

For example, Figure 8 shows an underdriven receiver. To correct this you can either
amplify the power entering the receiver, or decrease the receiver reference level.
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Figure 8. Underdriven Receiver

Notice that the constellation plots for almost all of these signals appear similar. Only the
overdriven state is distinctively recognizable from the constellation. Symbol rate error
can be recognized by the V−shaped envelope that appears on a plot of EVM per
individual symbol.

Note  The QAM Demodulation LabVIEW example that ships with the Modulation
Toolkit contains code for detection of over/underdriven signal power conditions.

Verify that the pulse shaping filter parameters— filter type and filter constant (alpha) —− are
matching on both the transmitter and receiver. Also make sure that the pulse shaping filter length
is set appropriately.

5. 

Note  For small filter constants (alpha < 0.25), verify that the pulse shaping filter length
is set to 16 or larger.

For example, Figure 9 shows a wrong value entered for alpha (filter parameter). The transmitter
uses an alpha = 0.3, and the RFSA uses an alpha = 0.5.
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Figure 9. Filter Alpha Value Mismatch

In contrast, Figure 10, shows the wrong filter selection.  The transmitter uses a root raised cosine
filter, but the RFSA specifies a raised cosign filter.

Figure 10. Filter Type Mismatch
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For wide real−time bandwidth signal generation (span >500 kHz), enabling the Digital IF
Equalization property improves modulation quality by compensating for the gain/phase response
variations in the passband of the NI 5610 upconverter module.

6. 

For example, Figure 11 shows a wide bandwidth signal. The constellation shown below is for a
signal with a symbol rate of 4 MS/s. All other figures have a symbol rate of 100 kHz. 

Figure 11. Wide Bandwidth (>500 kHz) Signal

Tip  With a wide bandwidth equalization may be required.

Front Panel ACCESS LED is Off When PXI Chassis is On

Failure to illuminate ACCESS LED may indicate a problem with the PXI power rail, a hardware module,
or the LED. Troubleshoot this issue as follows:

Power off your PXI chassis1. 
Remove any front panel connections between the NI 5670 modules.2. 
Remove the NI 5670 hardware modules and inspect for damage. Do not reinstall a damaged
device.

3. 

Reinstall both NI 5670 hardware modules in different PXI Slots. Use the procedure detailed in the
Installing the Hardware section of the NI 5670 RF Signal Generator Getting Started Guide.

4. 

Power on your PXI chassis.5. 
If either ACCESS LED still fails to light, contact NI technical support at ni.com/ask or call
866−275−6964 and ask to speak with a customer service representative.

6. 
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Hardware Module Does Not Appear in MAX

Use the following procedure if either NI 5670 hardware module does not appear in Measurement
&Automation Explorer (MAX):

In the MAX Configuration pane, click to highlight the NI−DAQmx Devices folder and press to
refresh the list of installed devices.

1. 

If either module is still not listed, power down the system, ensure the NI 5670 hardware is
correctly installed, and restart.

2. 

If either module still fails to appear in the MAX NI−DAQmx Devices folder, contact NI technical
support at ni.com/ask or call 866−275−6964 and ask to speak with a customer service
representative.

3. 

A Module Fails the Self−Test

The MAX self−test performs a brief test of device resources. If either module of the NI 5670 hardware
does not pass the self−test, perform the following procedure:

Reboot your system.1. 
Launch MAX and perform the self−test again.If the module still fails the self−test, proceed to
step three.

2. 

Uninstall and reinstall the NI−RFSG driver software.3. 
If either module still fails the self−test, contact NI technical support at ni.com/ask or call
866−275−6964 and ask to speak with a customer service representative.

4. 

The NI 5670 Test Panel Fails

The NI 5670 test panel tests both hardware modules as a single instrument. If the test panel fails or
generates an error, perform the following procedure to the following steps to locate the problem:

Verify that both NI 5670 modules are interconnected through the front panels as shown in Figure
1 below.

1. 
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Figure 1: NI 5670 Front Panel Interconnection

Ensure that all front panel connections are secure. Loose connections can impair instrument
operation.

2. 

Launch MAX by navigating to
Start»Programs»National Instruments»Measurement Automation or by clicking the MAX
desktop icon:.

3. 

Navigate to the Device and Interfaces»NI−DAQmx Devices folder.4. 

Right−click NI 5610 and select Properties as shown in Figure 2 below.5. 
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Figure 2. Select Properties From the NI 5610 MAX Right−Click Menu

In the NI 5610 Device Properties dialog, verify that the proper NI 5421 AWG module (that is,
the one interconnected to the NI 5610 upconverter module) is associated as shown in Figure 3.

6. 

Figure 3. The NI 5610 Properties Dialog Displays the Associated AWG

If there is no AWG associated with the NI 5610, right−click the dropdown list to select an
available NI 5421 AWG module to associate as shown in the Configuring the Modules in MAX
section in the NI 5670 Vector Signal Generator Getting Started Guide.

7. 

When the correct NI 5421 AWG module is specified, click OK to return to MAX.8. 
In the MAX Configuration pane, right−click NI 5610 and select Test Panels as shown in Figure
4.

9. 
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Figure 4. Open the NI 5670 Test Panel from the NI 5610 Right−Click Menu

In the Test Panels window, click the NI 5610 tab to view the NI 5610 test panel shown in Figure
5 below.

10. 
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Figure 5. Click the NI 5610 Tab to View the Upconverter Module Test Panel

The NI 5610 tab verifies PLL locking and proper functioning of the upconverter hardware.
Specify center frequency and gain settings.

11. 

Click the Start button to run the NI 5610 upconverter test panel.12. 

During operation of the test panel, the ACTIVE LED on the NI 5610 upconverter module front
panel is illuminated, and the test panel is displayed as shown in Figure 6.

13. 

Figure 6. The NI 5670 Test Panel During Operation

Click Stop to halt upconverter operation.14. 
If the NI 5610 test panel generates an error, shut down your system and reinstall the RF Vector
Signal Generator software and hardware.

15. 

If the NI 5610 test panel does not generate an error, continue with the following steps:

Click the NI PXI−5670 tab to return to the NI 5670 test panel.16. 
Click Start in the NI 5670 test panel to begin waveform generation and verify proper operation.17. 
Click Stop to halt signal generation and Close to return to the MAX main window.18. 
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If the NI 5670 test panel generates errors after successful operation of the NI 5610 test panel, complete
the following steps:

Power down your PXI chassis1. 
Disconnect the NI 5670 front panel coaxial cables.2. 
Remove and reinstall your NI 5421 AWG hardware module.3. 
Reconnect the NI 5670 front panel cables securely as shown in Figure 9.4. 
Restart your system and run the Self−Test Both Modules and Test Panels procedures detailed in
the NI 5670 Getting Started Guide document.

5. 

If failures continue, contact NI technical support at ni.com/ask or call 866−275−6964 and ask to speak
with a customer service representative.
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Important Information

Technical Support and Professional Services

Visit the following sections of the National Instruments Web site at ni.com for technical support and
professional services:

Support—Online technical support resources include the following:
Self−Help Resources—For immediate answers and solutions, visit our extensive library
of technical support resources available in English, Japanese, and Spanish at
ni.com/support. These resources are available for most products at no cost to registered
users and include software drivers and updates, a KnowledgeBase, product manuals,
step−by−step troubleshooting wizards, conformity documentation, example code,
tutorials and application notes, instrument drivers, discussion forums, a measurement
glossary, and so on.

♦ 

Assisted Support Options—Contact NI engineers and other measurement and automation
professionals by visiting ni.com/support. Our online system helps you define your
question and connects you to the experts by phone, discussion forum, or email.

♦ 

• 

Training—Visit ni.com/training for self−paced tutorials, videos, and interactive CDs. You can
also register for instructor−led, hands−on courses at locations around the world.

• 

System Integration—If you have time constraints, limited in−house technical resources, or other
project challenges, NI Alliance Program members can help. To learn more, call your local NI
office or visit ni.com/alliance.

• 

Declaration of Conformity (DoC)—A DoC is our claim of compliance with the Council of the
European Communities using the manufacturer’s declaration of conformity. This system affords
the user protection for electronic compatibility (EMC) and product safety. You can obtain the
DoC for your product by visiting ni.com/hardref.nsf.

• 

Calibration Certificate—If your product supports calibration, you can obtain the calibration
certificate for your product at ni.com/calibration.

• 

If you searched ni.com and could not find the answers you need, contact your local office or NI corporate
headquarters. You also can visit the Worldwide Offices section of ni.com/niglobal to access the branch
office Web sites, which provide up−to−date contact information, support phone numbers, email
addresses, and current events.

Warranty

Both hardware modules of the NI 5670 RF Vector Signal Generator are warranted against defects in
materials and workmanship for a period of one year from the date of shipment, as evidenced by receipts
or other documentation. National Instruments will, at its option, repair or replace equipment that proves to
be defective during the warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute
programming instructions, due to defects in materials and workmanship, for a period of 90 days from date
of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option,
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repair or replace software media that do not execute programming instructions if National Instruments
receives notice of such defects during the warranty period. National Instruments does not warrant that the
operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked
on the outside of the package before any equipment will be accepted for warranty work. National
Instruments will pay the shipping costs of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been
carefully reviewed for technical accuracy. In the event that technical or typographical errors exist,
National Instruments reserves the right to make changes to subsequent editions of this document without
prior notice to holders of this edition. The reader should consult National Instruments if errors are
suspected. In no event shall National Instruments be liable for any damages arising out of or related to
this document or the information contained in it.

Except as specified herein, National Instruments makes no warranties, express or implied, and
specifically disclaims any warranty of merchantability or fitness for a particular purpose. Customer's
right to recover damages caused by fault or negligence on the part of National Instruments shall be
limited to the amount theretofore paid by the customer. National Instruments will not be liable for
damages resulting from loss of data, profits, use of products, or incidental or consequential damages,
even if advised of the possibility thereof. This limitation of the liability of National Instruments will
apply regardless of the form of action, whether in contract or tort, including negligence. Any action
against National Instruments must be brought within one year after the cause of action accrues. National
Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control.
The warranty provided herein does not cover damages, defects, malfunctions, or service failures caused
by owner's failure to follow the National Instruments installation, operation, or maintenance instructions;
owner's modification of the product; owner's abuse, misuse, or negligent acts; and power failure or surges,
fire, flood, accident, actions of third parties, or other events outside reasonable control.

Copyright

Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic
or mechanical, including photocopying, recording, storing in an information retrieval system, or
translating, in whole or in part, without the prior written consent of National Instruments Corporation.

Trademarks

NI−RFSG, National Instruments™, and ni.com™ are trademarks of National Instruments Corporation.

Product and company names mentioned herein are trademarks or trade names of their respective
companies.

Patents

For patents covering National Instruments products, refer to the appropriate location: Help»Patents in
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your software, the patents.txt file on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL
INSTRUMENTS PRODUCTS

(1) National Instruments products are not designed with components and testing for a level of
reliability suitable for use in or in connection with surgical implants or as critical components in any
life support systems whose failure to perform can reasonably be expected to cause significant injury to
a human.

(2) In any application, including the above, reliability of operation of the software products can be
impaired by adverse factors, including but not limited to fluctuations in electrical power supply,
computer hardware malfunctions, computer operating system software fitness, fitness of compilers and
development software used to develop an application, installation errors, software and hardware
compatibility problems, malfunctions or failures of electronic monitoring or control devices, transient
failures of electronic systems (hardware and/or software), unanticipated uses or misuses, or errors on
the part of the user or applications designer (adverse factors such as these are hereafter collectively
termed "system failures"). Any application where a system failure would create a risk of harm to
property or persons (including the risk of bodily injury and death) should not be reliant solely upon
one form of electronic system due to the risk of system failure. To avoid damage, injury, or death, the
user or application designer must take reasonably prudent steps to protect against system failures,
including but not limited to back−up or shut down mechanisms. Because each end−user system is
customized and differs from National Instruments' testing platforms and because a user or application
designer may use National Instruments products in combination with other products in a manner not
evaluated or contemplated by National Instruments, the user or application designer is ultimately
responsible for verifying and validating the suitability of National Instruments products whenever
National Instruments products are incorporated in a system or application, including, without
limitation, the appropriate design, process and safety level of such system or application.

Related Documentation

These documents may contain information that you might find helpful as you use your NI−RFSG module.

NI 5670 RF Vector Signal Generator Getting Started Guide, available in PDF format at
Start»Programs»National Instruments»NI−RFSG»Documentation.

• 

For the latest NI−RFSG development information, visit the NI Developer Zone at
ni.com/instruments. Search for the latest NI−RFSG examples at ni.com/examples. These links
require an internet connection.

• 

NI 5670 RF Vector Signal Generator User Manual, available in PDF format at
Start»Programs»National Instruments»NI−RFSG»Documentation.

• 

NI Signal Sources Online Help, available at Start»Programs»National
Instruments»NI−FGEN»Documentation.

• 

NI 5670 RF Vector Signal Generator Specifications, available in PDF format at
Start»Programs»National Instruments»NI−RFSG»Documentation»Specifications.

• 

NI 5421 AWG Module Specifications, available in PDF format at Start»Programs»National• 
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Instruments»NI−FGEN»Documentation»Hardware Specifications.

Visit ni.com/manuals for the most current revisions of documentation and for newly released
documentation.
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